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Collect 3D Features from a Stereo Map 

Time: 1 hour 

 

Overview  

The Los Angeles city property map for the Hollywood Hills area consists of 2D building footprints that do 

not have any z-values associated to rooftop vertexes. To visualize new and rebuilt properties it is important 

to have accurate z values as the area is in hilly terrain and city bylaws regulate maximum heights allowed 

for new and redeveloped buildings.  

Upon inspection and reviewing the area with newer imagery, it is noticeable that several building footprints 

in the area have changed and that the pace of redevelopment and rebuilding in the area outpaces the rate 

at which officials can update their database. It is also obvious that many of the newly built and redeveloped 

homes consist of multiple levels and are terraced to take advantage of elevation in a way that maximizes 

the view and displays unique architectural details.  It is unclear if these buildings now meet bylaws with 

regards maximum height and a 3D map of building rooftop heights would greatly assist in policing and 

regulating development. 

Using a collection of stereo imagery loaded into a mosaic dataset, you will use stereo viewing and 

mapping in ArcGIS Pro to collect new 3D rooftop point features. This will help establish a pattern that 
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city officials can use to visually analyze imagery and compile three-dimensional (3D) features that can be 

used to update existing data and determine if bylaws are being broken. 

In this lesson you will learn the following: 

• Setting up a stereo environment 

• Setting up a stereo map collection  

• Stereo mapping functionality in ArcGIS Pro 

• Creating new features from a stereo map 

About 

Stereoscopy is a technique that uses overlapping imagery acquired from different locations to produce a 3D 

model that emulates true binocular vision. The main applications of photogrammetric stereo techniques 

are the identification, measurement, and manual digitizing of 3D features from vertical overhead imagery. 

 

Recently, with the advent of high-resolution multispectral imagery and availability of digital elevation 

models (DEMs) and GPS survey control, land base layers are created and updated using an orthorectified 

image base, and remote-sensing and image processing techniques can be used to automatically identify and 

classify features at photogrammetric accuracy.  

 

However, a major advantage of manual stereo compilation is its reliance on the combination of human 

vision and cognitive abilities to identify and collect features not possible with computer vision and 

processing. Examples include collecting ground elevation points; compiling buildings, roads, and other 

ground features obscured by vegetation; collecting important breaklines; and identifying features based on 

physical 3D attributes and cues. 

 

Stereo mapping in ArcGIS Pro means that all the data in the ArcGIS platform is both discoverable and 

immediately useful in your 3D mapping projects. Stereo feature data can flow out to 3D scenes for 

visualization, as well as back into the stereo view for editing. This data is also immediately available for GIS 

modeling and useable in time-critical decision support scenarios. 

Prerequisites 

• ArcGIS Pro  
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• ArcGIS Image Analyst extension 

• Either active shutter eyewear or anaglyph 3D glasses 

Active shutter eyewear 

Active shutter eyewear generally has a better stereo effect because it is deployed as part of an active 

shutter 3D system, which is a technique for displaying stereoscopic 3D images. Unlike red and cyan color 

filter (anaglyph) 3D glasses, active shutter glasses are color neutral, enabling 3D viewing in the full color 

spectrum. 

Active shutter 3D systems work by presenting the image intended for the left eye while blocking the right 

eye's view, then presenting the right-eye image while blocking the left eye and repeating this so rapidly 

that the interruptions do not interfere with the perceived fusion of the two images into a single 3D 

image.  

If you are using active shutter eyewear, you will need the appropriate hardware. 

Anaglyph 3D eyewear 

Anaglyph 3D is the name given to the stereoscopic 3D effect achieved by encoding each eye's image 

using filters of chromatically opposite colors, typically red and cyan.  

Anaglyph 3D images contain two differently filtered colored images, one for each eye. When viewed 

through the color-coded anaglyph glasses, each of the two images reaches the eye it's intended for, 

revealing an integrated stereoscopic image. This tricks the brain into perceiving the fused images as a 

three-dimensional scene or composition. 

Download the sample data 

1. Download the SampleData.zip compressed folder. 

2. Once the download is complete, unzip the file. 

3. Locate and select the SampleData folder, and then move or copy the folder and its contents directly 

to your computer’s C drive.  

4. Confirm the following folder structure exists at the location you have selected \SampleData\Vexcel-

Hollywood\0_MosaicDataset\VexcelHollywood.gdb. 

Now you have sample data to use in your stereo workflow. 

https://pro.arcgis.com/en/pro-app/help/analysis/image-analyst/stereo-mapping-in-arcgis-pro.htm
https://downloads.esri.com/learnarcgis/collect-3D-features-from-a-stereo-map/SampleData.zip
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Set up the stereo environment 

In ArcGIS Pro, stereo mapping includes a stereo map viewer that displays and manipulates stereo image 

pairs from satellite and aerial sensor platforms. The stereo display supports multispectral, three-band, and 

panchromatic imagery; direct enhancement of imagery; superimposition of 3D GIS data on stereo imagery; 

zooming and roaming; and other adjustments.  

Preparing imagery for stereo viewing in ArcGIS  

To display data in stereo mode in ArcGIS Pro, you need to turn on the correct stereoscopic mode. This task 

only needs to be performed once, and the application will always use this mode for new projects you create 

until you change modes. 

1. Start ArcGIS Pro. On the bottom of the start screen, click Settings. 

  

2. Click Options. 

3. Click the Display tab. 

4. For Stereoscopic mode, choose either 3D cyan/red glasses or 3D shutter glasses, depending on the 

type of eyewear you are using.  

https://community.esri.com/community/gis/imagery-and-remote-sensing/blog/2018/05/18/preparing-imagery-for-stereo-viewing-in-arcgis
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If you are using shutter glasses, make sure that your system meets the display requirements. 

A warning appears at the bottom of the dialog box. Since you do not have a project open currently, you 

can disregard it.  

5. Click OK. 

The ArcGIS Pro application is now ready to display data in stereo using the type of stereo viewing 

glasses you have specified. 

6. Click the Back arrow to return to the start screen. 

7. Under New, click Start without a Template. 

 

https://pro.arcgis.com/en/pro-app/help/analysis/image-analyst/stereo-mapping-in-arcgis-pro.htm#ESRI_SECTION2_CB3688E7D0334670846463A68E6B2517


Collect 3D Features from a Stereo Map 

 

This provides the ability to open ArcGIS Pro without having to first save a project. You can open the 

application and carry out data management tasks that don’t require a project to save changes. 

8. In the Catalog pane, right-click Folders and choose Add Folder Connection. 

 

9. On the Add Folder Connection dialog box, browse to \SampleData\Vexcel-Hollywood. 
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10. Click OK to create the connection and close the Add Folder Connection dialog box. 

11. On the ribbon, click the Insert tab.  

12. In the Project group, click the New Map drop-down arrow and choose New Stereo Map.  

 

A new stereo map appears in your display, and the Stereo Map tab is available. The tab has all the 

tools you need to view and work with the stereo pairs. 
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13. Click the Stereo Map tab and review the tools contained in the Clipboard, Navigate, and Layer groups. 

The Stereo Source group has a split button to set and clear the stereo source. When a stereo map is 

initiated, you need to identify the data source for the stereo project. 

 

The Stereo Display group has tools to set up your selected image pairs for your stereo workflow, 

and the Stereo Model group has the tools to choose the stereo pair you want to work with in the 

stereo source.  

  

The Cursor group allows you to select different cursor shapes, the Sub Views group has tools to help 

you view stereo imagery in an overview or magnifier window and the Inquiry group 

contains Locate and Measure tools.  

14. From the Stereo Source group, click the Set Source button. 

A stereo map's data source is a stereo model consisting of a stereo image pair or a collection of stereo 

models managed as a mosaic dataset.  

15. On the Set stereo source dialog box, choose Stereo model collection.  
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The browse results are filtered to only display mosaic datasets as a stereo source type.  

16. On the Set stereo source dialog box for Source collection, click the Browse button, and then using the 

folder connection, locate \SampleData\Vexcel-Hollywood\0_MosaicDataset\VexcelHollywood.gdb.  

17. From VexcelHollywood.gdb, select the VexcelHollywood_Stereo mosaic dataset and click OK. 

 

18. On the Set stereo source dialog box, click OK. 

The VexcelHollywood_Stereo mosaic dataset is added to the stereo map.  

Note: If you saved the SampleData folder to a location other than the C drive, your mosaic dataset 

stereo images may not display. You will need to use the Repair Mosaic Dataset Paths tool to update 

mosaic dataset source image paths to the new location, or move the folder to the C drive. 

https://pro.arcgis.com/en/pro-app/tool-reference/data-management/repair-mosaic-dataset-paths.htm
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19. In the Contents pane, right-click Stereo and choose Properties. 

 

20. On the Map Properties: Stereo dialog box, click Coordinate Systems. 

 

Verify that the stereo map coordinate system is defined as 

NAD_1983_2011_StatePlane_California_V_FIPS_0405. This is the same projection as the mosaic 

dataset. 

Note: The spatial reference of the stereo source cannot be changed, but the stereo map can display 

the supported layer in any projection. However, best practice is to avoid reprojection whenever 

possible. 

21. On the Map Properties: Stereo dialog box, click General and review the current unit properties. 
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Notice the following: 

• Map units are set to meters. 

• Display units are set to decimal degrees. 

• Elevation units are set to feet. 

These can be modified based on project requirements. 

22. Click Cancel to close the Map Properties pane. 

23. Review the stereo map view. 

When a stereo pair is loaded, the stereo map view displays two images where the epipolar lines are 

parallel to the x-axis. Epipolar is the geometry of stereo vision and results when two cameras view a 

3D scene from two distinct positions, resulting in constraints between the image points. 
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In the stereo map, the cursor always returns x, y, and z, which are displayed in the current projection 

units below the map. 

24. In the Stereo Map display, use pan and ctrl zoom to navigate the imagery. If you like, experiment using 

navigation keys to manipulate the cursor and map display.  

Review the Stereo map navigation help topic for more details. 

25. Locate and zoom to the triangular building near the upper right of the map. 

https://pro.arcgis.com/en/pro-app/help/analysis/image-analyst/stereo-map.htm
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26. Using the cursor, point to one of the building corners and review the measurement details reported in 

the lower center of the map. 

Note: Your current Z-value will not change as you roam across the image, later you will adjust the z-

coordinate before collecting a feature. 

 

Notice that the x- and y-values are reported in decimal degrees and the z-value in feet. If no vertical 

datum is defined, the z-unit (ft) will be the same as that defined in the mosaic dataset. 
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27. Next use your stereo glasses to explore (pan and zoom) the stereo map in 3D. 

28. On the Stereo Map tab, in the Sub Views group, click Overview. 

 

The Overview window appears in the upper left corner of the stereo map and shows the zoomed-

out location of your current extent. This can help you navigate around the stereo pairs in your 

project without leaving your current stereo display resolution. 

Hint: Press the O shortcut key to turn the Overview window on or off.  

29. On the stereo map, in the overview area, move the gray extent indicator box to pan around the stereo 

map. 

 

30. In the Sub Views group, check Overview to turn it off, and check Magnifier to turn it on. 

The Magnifier window appears in the lower right corner of the stereo map and shows a zoomed-in 

view of the location of your cursor. This can help you view an object closely, without having to leave 

your current stereo display resolution. 
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31. On the stereo map, move your cursor around and notice how the magnifier displays an enlarged view 

of features located below the current cursor position. 

 

32. In the Sub Views group, check Magnifier to turn it off.  

Hint: Press the W shortcut key to turn the Magnifier window on or off. 

33. Remove your stereo glasses before continuing. 

Locate features for updating 

Next, you will select a stereo pair containing features for updating from the stereo model. However, 

before selecting a stereo pair and the roof of a building to update, you should locate a property that has 

recently been redeveloped and may not comply with local height restrictions. 

1. In the Catalog pane, expand Folders. 

2. If necessary, expand the Vexcel-Hollywood folder. 

HollywoodHills.mpkx is a packaged 2D map displaying the World Topographic basemap and a layer of 

building footprints for homes in the Hollywood Hills that require review and possible updating. 

3. Right-click HollywoodHills.mpkx and choose Add And Open. 
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A 2D map named Hollywood Hills is added to your project. It contains one 2D layer of building 

footprints. 

4. Select the Hollywood Hills map. 

5. On the ribbon, in the Navigate group, click Bookmarks and select the Update Focus bookmark. 

 

6. In the Contents pane, use the check box to turn the buildingfootprints layer on and off and observe the 

building footprints on the underlying basemap. 
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With the current basemap and the 2D building footprints, it is difficult to gain an accurate 

perspective of the heights of buildings and if any buildings exceed height restrictions. 

7. On the Map tab, in the Layer group, change the basemap to Imagery. 

8. Once again, turn the buildingfootprints layer on and off and observe the building footprints on the 

underlying basemap. 

 

This time it is easier to observe elevation changes, but it is still difficult to observe building heights in 

relation to elevation.  

9. From Bookmarks, select Redeveloped Building. 

The map updates and it is clear that building footprints in this area look different than those on the 

basemap. You should investigate these, as it appears that several original buildings have either been 

rebuilt or extensively modified. 
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The outline of one of the buildings on Maravilla Dr appears different and should be investigated. 

Next, you will convert the 2D map to a 3D local scene to observe the effect of terrain. 

10. Change the basemap to Topographic. 

11. On the ribbon, on the View tab, click Convert and choose To Local Scene. 

 

A new local scene named Hollywood Hills_3D is added to the project.  It would be useful to link the 

2D and 3D maps as well as the stereo map, so the same extent and scale are displayed in all maps. 

12.  Click the Stereo view tab to activate the stereo map. 

13. In the Stereo map, pan and zoom to the large triangular structure consisting of two buildings located 

near the center of the stereo map.  
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14. On the View tab, in the Link group, click Link Views and select Center and Scale. 

 

All maps in the project are linked. Both the Hollywood Hills and Hollywood Hills_3D maps display the 

same extent and features, but the stereo map needs to be updated to display the stereo pair that 

covers the Hollywood Hills area. Before you update the stereo pair, review the linked maps. 

15. If necessary, hide the Catalog pane and then reposition and dock the Hollywood Hills and Hollywood 

Hills_3D maps to the right of the stereo map.  

Hint: To move and dock a map view, click and drag its view tab. Point to one of the docking targets that 

appear to dock the view to that target. 
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16. In the Hollywood Hills_3D scene, use the navigator tool to tilt the scene and change direction. Notice 

how the linked Hollywood Hills 2D and stereo maps update in response to your navigation. 

 

17. Click the Hollywood Hills map and zoom to your target building by applying the Redevelopment 

building bookmark. 
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Update the stereo pair to Hollywood Hills 

Next, you’ll update the stereo map to cover a pair of images that fall within the Hollywood Hills area you 

are updating. 

1. Click the stereo map to activate the Stereo Map tab. 

2. On the Stereo Map tab, in the Stereo Model group, click the Model Selector button. 

 

The  Stereo Model Selector pane opens, which allows you to manage and select stereo pairs for 

display.  

For more details on the Stereo Model Selector pane, review the Stereo Model Selector pane help 

topic. 

https://pro.arcgis.com/en/pro-app/help/analysis/image-analyst/stereo-model-selector-pane.htm
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The top of the Stereo Model Selector pane displays the footprints of all the stereo pairs in your stereo 

source. The bottom of the pane lists all the available stereo pairs, which can be filtered by polygon, map 

extent, or attribute. 

3. In the Stereo Model Selector pane, click the Define stereo model collection using a filter button. 

When a stereo model is added to the stereo map, the first stereo pair in the model is displayed 

(generally the pair located in the lower left of the collection). Using the Stereo Model Selector pane, 

you can change and select the stereo pair that you want to work with from the mosaic dataset source.  

4. Choose the Filter by map extent option and select Hollywood Hills.  

 



Collect 3D Features from a Stereo Map 

 

The Stereo Model Selector pane updates to display stereo pairs filtered to the extent of the 

Hollywood Hills 2D map. 
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5. In the Stereo Model Selector pane, click the Zoom to selected button to review the extent of the 

stereo pair with ID 173.  

 

Review the additional stereo pairs filtered by the extent of the Hollywood Hills map. Notice that the 

selected pairs overlap each other. 

6. In the Stereo Model Selector pane, select the stereo pair with ID 176.  

This pair appears to cover the Hollywood Hills area around Maravilla Drive and is centered within the 

area you have identified as showing a large amount of redevelopment. 

7. In the Stereo Model Selector pane, use the Zoom to selected button to review the extent of the stereo 

pair.  

8. Next, click the Add to stereo button to load the selected stereo model. 
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9. Close the Stereo Model Selector pane. 

10. In the stereo map, use the left mouse button to pan and the right mouse button to zoom to navigate 

the stereo map in roaming mode. 

11. With your cursor active in the stereo map, press F8 to temporarily change the stereo pointer mode 

from roaming to fixed. 

This allows you to navigate the map without panning the mouse. Notice that the fixed mode also 

affects the linked map and scene. 

12. Return to roaming mode by pressing F8 again. 

13. Use the Redevelopment Building bookmark or map navigation tools to focus on the house you 

identified earlier.  

14. In the stereo map, zoom in on the house by pressing the Ctrl key while rotating the wheel button. 
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15. Put on your 3D glasses and examine the house in 3D. 

The right and left images are offset from each other, making it difficult to effectively view the 

building 3D. You can correct this by adjusting the x-parallax. 

16. In the stereo map, while wearing the 3D glasses, press Ctrl + Right Arrow or Ctrl + Left Arrow to change 

the x-parallax. The two images move toward or away from each other in the x (horizontal) direction. 

Keep moving the images until they merge into a single image and look clear. 
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Note: You may not be able to achieve a perfect registration, but while wearing the 3D glasses you 

should be able to achieve a very good match and clearly see the house in 3D. As you zoom to 

specific areas on the image, you will need to readjust the registration to improve accuracy. 

Your stereo environment is now set up with a stereo pair. You can start your editing workflow.  

Create the BuildingHeights feature class 

Now that your stereo model is set up, you are ready to collect 3D features in stereo mode. The editing 

experience in a stereo map is consistent with the standard editing experience in ArcGIS Pro for creating 

and editing feature class data. While editing, you can use existing layers, symbols, and templates. The 

output of your feature creation or editing session is saved directly to a geodatabase.  

1. In the Contents pane of both the Hollywood Hills 2D and Hollywood Hills_3D maps, check off 

the building footprints layer.   
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This layer is a 2D layer obtained from the City of Los Angeles. You will be collecting 3D point 

features and need a z-enabled feature class to store the new building heights. 

2. In the Catalog pane, in folder connections, expand the Vexcel-Hollywood connection.  

Hint: If you hid the Catalog pane earlier, on the View tab, in the Windows group, click Catalog 

Pane. 

3. Expand the 0_MosaicDataset folder and right-click VexcelHollywood.gdb. 

4. Choose New and select Feature Class. 

 

5. In the Create Feature Class window, make the following changes: 

• For Name, type BuildingHeights. 

• For Feature Class Type, select Point. 

• For Geometric Properties, ensure Z Values is checked. 
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6. Click Next. 

The next page allows you to add attribute fields. You do not want to add fields yet. 

7. Click Next.  

Next, you'll choose the feature class's coordinate system. A coordinate system defines positions 

and measurement values of geographic features on a map. You'll use the same coordinate system 

defined for the mosaic dataset in your map. 

8. If the Current XY coordinate system is already set to NAD 1983 (2011) StatePlane California V 

FIPS 0405 (Meters), click Finish. Otherwise, you’ll import this coordinate system. 

9. In the Spatial Reference window, click the Add Coordinate System button. 

10. Choose Import Coordinate System. 
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11. In the Import coordinate system window, browse and select \SampleData\Vexcel-

Hollywood\0_MosaicDataset\VexcelHollywood.gdb\VexcelHollywood_Stereo. 

This will ensure the new feature class has the same coordinate system as the 

VexcelHollywood_Stereo mosaic dataset.  

12. Click Finish to create the BuildingHeights feature class. 

13. From the Catalog pane, add the BuildingHeights feature class to the Stereo map, and then do the 

same for the Hollywood Hills 2D and Hollywood Hills_3D maps.  

14. In each of the three maps, change the point symbology for the BuildingHeights layer to a red dot. 

Create features using the stereo map  

1. In the stereo map Contents pane, click the BuildingHeights layer to select it for editing. 

2. On the ribbon, click the Edit tab. 

For more information about editing, see A quick tour of editing.  

3. On the Edit tab, in the Snapping group, click Snapping to turn snapping on. 

4. In the Snapping menu, ensure that both End and Edge snapping are selected. 

https://pro.arcgis.com/en/pro-app/help/editing/a-quick-tour-of-editing.htm
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By selecting End and Edge snapping, new features will snap to the edges or ends of existing 

features. 

5. In the Snapping menu, click Snapping Settings. 

The XY tolerance is set to 10 pixels, which means that snapping will only take place when the 

new feature is within 1 to 10 pixels of the end or edge of an existing feature.  

 

6. Click OK to close Snapping Settings. 

7. In the Features group, click the Create button. 

 

8. The Create Features pane appears.  

9. Position and dock the pane before continuing.  



Collect 3D Features from a Stereo Map 

The Create Features pane displays templates for layers that are editable and includes tools that 

can be used to construct or modify features.  

  

10. Click the BuildingHeights layer template.  

Notice that the template has three construction tools: Point, Point At End of Line, and Create Points 

Along Line. 

Before you start collecting a new building height feature, you need to adjust and correct the z-

coordinate or floating mark in the stereo map to ensure you are constructing features with the 

correct z-value. 

11. In the stereo map, point to the center of the highest roof section of the building and rotate the 

wheel button to adjust the z-coordinate.  

 

To increase the z-value, rotate the wheel button backward. To decrease the z-value, rotate the 

wheel button forward. You will have the correct height when the cursor appears to sit on top of 

the feature you are viewing, and the red and blue crosses come together.  
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12. In the Create Features pane, click the BuildingHeights template., then click the Point tool. 

 

13. On the stereo map, click and create a point in the center of the highest roof on the building. Each 

point you create has an x-, y-, and z-value as determined from the stereo map. 

 

14. Review the Hollywood Hills 2D map and notice the new point feature located in the center of the 

highest roof on the building. 

 

15. Review the Hollywood Hills_3D map and notice the new point feature located in the air above the 

center of the highest roof on the building. 
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The location of the point above the building footprint is expected, as the 3D scene is displaying 

the point at its correct z-value (height) as determined from the stereo map. 

Next, you will create a point for the lower-level terrace facing the street, and you may need to 

adjust the x-parallax before making the measurement, since focusing on a different height 

generally requires an adjustment. 

16. In the stereo map, zoom to the lower terrace and adjust the x-parallax. As you zoom closer, the 

stereo pair will need adjustment. 

17. In the stereo map, point to the lower terrace of the building and rotate the wheel button to adjust 

the z-coordinate.  
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18. From the Create feature template, use the Point tool to create a second point on the lower terrace. 

 

After the terrace point has been collected, all that remains for this building is an anterior 

addition in the lower middle.  

19. Zoom to the anterior addition and adjust the x-parallax.  

20. Using the same method as before, adjust the z-coordinate to match the elevation of the anterior 

addition. 

 

21.  From the Create feature template, use the Point tool to create the third point centered in the 

anterior addition.  
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22. In the stereo map, verify that you have successfully created three building-height point features. 

 

23. Review the Hollywood Hills 2D map and notice the three building-height features above the roof of 

the building. 

 

24. Review the Hollywood Hills_3D map and notice three building-height features above the roof of 

the building. 
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The anterior addition point appears offset since it is located downslope and at a lower elevation 

on the hillside. 

25. On the ribbon, on the Edit tab, in the Manage Edits group, click Save. 

26. In the Save Edits window, click Yes to save all edits. 

 Edits are saved to the BuildingHeights feature class. 

27. Open the Edit tab and use the Select tool to select all three points you collected.  

28. When the three points are selected, in the Selection group, click Attributes. 

 

The Attributes pane appears, showing the three selected features.  
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29. Choose the Geometry tab from the bottom section of the pane to see the x-, y-, and z-values for 

each feature.  

 

You should see z-values (in meters) that are largest for the first feature you collected and 

smallest for the last feature you collected. Note that these -values represent height above sea 

level.  

You can collect additional features from the stereo map as needed. 

30. On the Project tab, click Save to save your Stereo mapping project. 

Summary 

Using a collection of stereo imagery loaded into a mosaic dataset, you used the stereo viewing and 

mapping functionality in ArcGIS Pro to collect new 3D rooftop features. This will help establish a pattern 

that city officials can use to visually analyze stereo imagery to compile 3D features that can be used to 

update the existing database and determine if bylaws are being broken. 

For more information on ArcGIS Pro stereo mapping 

• Introduction to stereo mapping 

• Stereo mapping in ArcGIS Pro 

• Stereo map 

• Stereo Model Selector pane 

• Stereo map navigation 

https://pro.arcgis.com/en/pro-app/help/analysis/image-analyst/introduction-to-stereo-mapping.htm
https://pro.arcgis.com/en/pro-app/help/analysis/image-analyst/stereo-mapping-in-arcgis-pro.htm
https://pro.arcgis.com/en/pro-app/help/analysis/image-analyst/stereo-map.htm
https://pro.arcgis.com/en/pro-app/help/analysis/image-analyst/stereo-model-selector-pane.htm
https://pro.arcgis.com/en/pro-app/help/analysis/image-analyst/stereo-map.htm
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